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NEC Infrontia Corporation ("NEC-i") and its Licensor NEC 
Infrontia, Inc. ("NECII") grants to sublicense to the end-user  

("You") the use of the Software preinstalled in the InasetTM you 
acquired ("Product") pursuant to the following terms and 
conditions.

1. TERMS
(1) This Agreement is effective upon using the Product and 

shall remain in force until terminated. 
(2) You may terminate it voluntarily at any time by written 

notice as indicated in Section 9. 
(3) NECII may terminate this Agreement without notice upon 

your failure to abide by this Agreement.
(4) All provisions of this Agreement relating to disclaimers of 

warranties, limitation of liability, remedies, or damage, and 
NECII or its supplier’s proprietary rights shall survive 
termination.

2. LICENSE
NECII grants you a nonexclusive and royalty-free license to use 
the software solely on the Product which is provided to you as 
preinstalled in the Product ("Software").

3.RESTRICTIONS
(1) You may not rent or lease the Software, but you may 

transfer the Product, the Software (not a part) and 
accompanying documentation on a permanent basis, 
provided that you retain no copies of the Software and the 
recipient agrees to be bound by all of the terms and 
conditions of this Agreement.

(2) You agree not to modify, alter, decompile, disassemble, 
reverse engineer or otherwise attempt to derive the Source 
Code of the Software. 

(3) You may not copy the Software.
(4) You may not use the Software other than in connection 

with the Product.
(5) You will not export or re-export the Software without the 

appropriate United States or foreign government licenses.

4. TITLE
Title to and ownership of the Software, related documentation 
and any reproduction thereof shall remain with NECII, its 
affiliates and its suppliers and the trademarks are the property 
of such trademark owners. This Agreement does not grant you 
any right (whenever by license, ownership or otherwise) in or to 
patents, copyrights, trade secrets, trade names, trademarks or 
any other intellectual property right with respect to the Software.

5. COPYRIGHT
THE SOFTWARE IS COPYRIGHTED AND, EXCEPT AS 
PERMITTED BY THIS AGREEMENT, YOU MAY NOT 
DUPLICATE THE SOFTWARE OR DISCLOSE IT TO ANY 
OTHER PARTY.

6. LIMITED WARRANTY
YOU AGREE THAT THE SOFTWARE IS PROVIDED AND 
LICENSED "AS IS." TO THE MAXIMUM EXTENT PERMITTED 
BY APPLICABLE LAW, NECII AND ITS SUPPLIERS 
DISCLAIM ALL OTHER WARRANTIES, EITHER EXPRESS 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, IMPLIED 

WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT, WITH 
REGARD TO THE SOFTWARE. YOU BEAR THE ENTIRE 
RISK RELATING TO THE QUALITY OF THE SOFTWARE 
AND, IF THE SOFTWARE PROVES TO HAVE ANY DEFECTS, 
YOU ASSUME THE COST OF ANY NECESSARY SERVICING 
OR REPAIRS. SOME STATES DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES, SO THAT THE 
ABOVE EXTENSION MAY NOT APPLY TO YOU. THIS 
WARRANTY GIVES YOU SPECIAL LEGAL RIGHTS AND 
YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM 
STATE TO STATE.

7. LIMITATION OF LIABILITY
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE 
LAW, IN NO EVENT SHALL NECII OR ITS SUPPLIERS BE 
LIABLE FOR ANY DAMAGES WHATSOEVER (INCLUDING, 
WITHOUT LIMITATION, LOSS OF USE, LOSS OF PROFIT, 
INTERRUPTATION OF BUSINESS, OR ANY INDIRECT, 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF 
ANY KIND) REGARDLESS OF THE FORM OF ACTION 
WHETHER IN CONTRACT, TORT (INCLUDING 
NEGLIGENCE), STRICT PRODUCT LIABILITY OR 
OTHERWISE, EVEN IF NECII HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL 
NECII BE LIABLE FOR ANY AMOUNT IN EXCESS OF THE 
AMOUNT YOU ACTUALLY PAID FOR THE SOFTWARE 
PORTION OF THE PRODUCT. BECAUSE SOME STATES DO 
NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY 
FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES, THE 
ABOVE LIMITATIONS MAY NOT APPLY TO YOU.

8. OTHERS
(1) This Agreement shall be construed and interpreted 

according to the laws of Connecticut.
(2) The Software is a "commercial item" as that term is defined 

in 48 C.F.R. 2.101, consisting of "commercial computer 
software" and "commercial computer software 
documentation" as such terms are used in 48 C.F.R. 
12.212. Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 
227.7202-1 through 227.7202-4, NECII provides the 
Software to U.S. Government End Users only pursuant to 
the terms and conditions therein.

(3) You are hereby notified that Wind River K.K. and its 
licensors ("Wind River") are a third-party beneficiary to this 
Agreement to the extent that this Agreement contains 
provisions which relate to your use of the software 
provided by Wind River. Such provisions are made 
expressly for the benefit of Wind River and are enforceable 
by Wind River in addition to NECII.

9. NOTICE
NEC Infrontia, Inc.
6535 N. State Highway 161, Irving, Texas 75039-2402
Attn: CNG Contracts Administration
Main Telephone: 214-262-2000

END USER LICENSE AGREEMENT
PLEASE READ CAREFULLY THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THE INASETTM: USING THE 
PRODUCT SHALL INDICATE THAT YOUR COMPANY HAS ACCEPTED THE TERMS AND CONDITIONS OF THIS LEGAL 
AGREEMENT. AS REFERENCED HEREIN, IF YOU DO NOT AGREE TO THESE TERMS AND CONDITIONS, YOU SHOULD 
IMMEDIATELY RETURN THE PRODUCT UNUSED TO THE COMPANY FROM WHICH YOU PURCHASED IT WITHIN A 
REASONABLE PERIOD OF TIME (NOT TO EXCEED ONE MONTH) FOR A FULL REFUND OF MONEY PAID FOR THE PRODUCT.
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How this Guide is Organized
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Introduction
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2
Phone Features
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Inaset Phone Features and Controls

Control keys

Ring Indicator

Display Screen

Enter key
Level Control keys

Soft keys

Speaker

Microphone

Cursor key
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Feature Descriptions

��������������	���������
�	��	��������������
�������������������
��������

Feature Description

Control keys Use to select an associated screen menu item in one of the phone 
applications.

Cursor & Enter keys
Use the four-way Cursor key to select options on the display 
screen and then press the Enter key to complete the selection 
action.

Directory key Launches the Directory application.

Display Screen Displays the various Inaset call functions and application 
screens.

Exit key Exit the soft key help menu.

Hold key Places the current call on hold.

Home key Starts the Home Application.

Menu key Displays the phone main menu.

Mic key Turns the built-in microphone ON or OFF (used in hands-free 
speakerphone mode).

Microphone Use in Hands-free Speakerphone mode.

soft keys
Used for various factory assigned features and to select the 
associated application function displayed at the bottom of the 
window.

Numeric keypad
Used when placing a call or for data input to an application
(Use for dialing a number with phone in Telephone mode. Use for 
data input with phone in Application mode.

Call Indicator Flashes when receiving an incoming call, lights steadily when a 
message has been left.

Security key Locks the Inaset and displays the Inaset screen saver. (With 
Inaset locked, press this key to display the password window.)

Speaker Use in Speakerphone mode.

Speaker key Turns the built-in Speaker ON or OFF.

Transfer key Use to transfer a call.

Level Control keys

Use these keys for:

• with phone ringing, increase/decrease ringer volume

• when using handset, increase/decrease handset volume

• during Speakerphone call, increase/decrease speaker volume

• with no call, increase/decrease LCD screen contrast
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3
Setup Options
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Setting Your Inaset Options

����$����/��	������������
�����������������

���������������%�����
����	
��	����#����������
���"����������
����������������������	����������
��	��������	�����+�����	����������,����������������������"�������
�������������������%���������	
��	���

Inaset Main Menu window
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Entering Text Using the Dial Keys
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Example: �������
��$����9�������:

Step  1 Press 7 four times, then press cursor right.

Step  2 Press 6 once, then press cursor right.

Step  3 Press 4 three times, then press cursor right.

Step  4 Press 8 once, then press cursor right.

Step  5 Press 4 two times, then press cursor right.

/�����	����������������
�����������������%����9������������������������
�	�����+����,�
�������������������������������������"��������������	�����
���������������������	��	
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��������������������������	��������������+	��	
��������
�,�����������
+	��	
����������,�

#����	����������	���"���+�������������	�������������,��	�������������

����
������� �!�"�#�$�+���
�,

#����	����������	���"���+�������������	�������������,��	�������������

����
�����%�&�'�(�)�*+�,�-�.�/���0��1��2�3�4�5�6�789���:

CAUTION

Only make changes to the Inaset options described in this manual. Changing other 
options and settings not described in this manual could cause Inaset to not operate. 
Should you encounter any problems changing options, contact your phone system 
administrator.



Setup Options         3-3

Inaset User Guide - Issue 1.0

Favorites
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Favorites List example

Setting Your Favorites

:������������������������������:����	���.

Step  1 Start the Setup application as described at the beginning of this chapter. 
At the Setup menu, use the cursor key to select Terminal and press the 
Enter key.

Step  2 Again use the cursor key to select Favorites and press the Enter key. 
The Terminal Favorites window displays.

IMPORTANT

BEFORE setting your Favorites, Inaset must be initially configured for call operation. 
Ensure your Inaset has been configured by your phone system administrator before 
proceeding with any Setup Options.
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Terminal Favorites window

Step  3 At the Terminal Favorites window, press the control key for the Favorite 
you want to add or change. The Favorites Set window displays (below).

Favorites Set window

Step  4 Press the control key for the selector box to display the four available 
choices of Not Assigned, Line keys, DSS keys and Fixed keys.

—If selecting Line keys, the Favorites Line Key Select window will 
display. Select the desired Line key that will appear as one of your 
Favorites and press the soft key for OK.
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Favorites Line Key Select window

—If selecting DSS keys, a window will display showing the available 
DSS keys. Select the desired DSS key that will appear as one of your 
Favorites and press the soft key for OK.

—If selecting Fixed keys, the Favorites Fixed Key Select window will 
display (below). Select the desired Fixed function you want to appear 
as one of your Favorites and press the soft key for OK.

Favorites Fixed Key Select window

Step  5 Repeat Steps 3-4 for any additional Favorites (up to six) you wish to set.
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Step  6 When you have made all your selections for Favorites, press the soft key 
for Back, then Press the soft key for Save to save your settings.

Step  7 Press the soft key for OK to confirm that you really want to save your 
settings.

Step  8 Press the soft key for OK to confirm to reset your Inaset phone. (These 
changes will not take affect until your Inaset phone has been reset.)

Step  9 When your Inaset phone has reset and reloaded, you can view your 
Favorites by selecting the control key for Favorites on the Inaset Home 
application.
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DSS Speed Dial Keys
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DSS Keys List example

Setting the DSS Keys

:��������������������������������!%%��������	���"���.

Step  1 Start the Setup application as described at the beginning of this chapter. 
At the Setup menu, use the cursor key to select Terminal and press the 
Enter key.

Step  2 Again use the cursor key to select DSS Keys and press the Enter key. 
The Terminal DSS Keys window displays.

IMPORTANT

BEFORE setting your DSS keys, Inaset must be initially configured for call operation. 
Ensure your Inaset has been configured by your phone system administrator before 
proceeding with any Setup Options.
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Terminal DSS Keys window

Step  3 At the Terminal DSS Keys window, press the control key for the DSS key 
you want to add or change. The DSS Key Set window displays (below).

DSS Keys Set window

Step  4 Press the control key for the selector box to display Assigned (available 
choices Not Assigned and Assigned).
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Step  5 Press the control key for Description and enter a description label for 
this key using the dial keys. (This could be a person’s name, department, 
office, or phone number.) (See Entering Text Using the Dial Keys in this 
chapter.)

—This description will be displayed on the DSS Key list for this key.

—Press the soft key for OK to complete the settings for this DSS key.

Step  6 Repeat the previous steps to configure any additional DSS Keys.

Step  7 When all keys have been labeled, press the soft key for Back, then press 
the soft key for Save to save the settings.

Step  8 Press the soft key for OK to confirm that you really want to save your 
settings, then press the soft key for OK to confirm to reset your Inaset 
phone. (These changes will not take affect until your Inaset phone has 
been reset.)

:������������������������������������������	�������	��������������������
��!%%��������	���"���

Step  1 On the Home Application window, press the control key for Function 
Keys.

Step  2 Press the control key for Feature, then press the control key for DSS 
Keys.

Step  3 Press the control key for one of the DSS keys labeled in the previous 
steps. Using the dial keys, enter the extension or external phone number 
that will be dialed for the key.

Step  4 Once again press the control key for Function Keys, then press the 
control key for Feature. The top of the window displays SPEED SET.

Step  5 Repeat these steps, as needed, for all DSS Keys that you previously 
labeled.

Using the DSS Keys

�������������������!%%�"���.

Step  1 Lift the handset and hear dial tone.

Step  2 Press the control key for DSS Keys on the Home Application window.

Step  3 Press the control key for the desired DSS key. The preset number will be 
dialed automatically.

NOTE

It is necessary to perform this sequence of steps quickly, as the Feature mode will 
automatically close after 1 minute.
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Display Screen Options
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Back Light Level
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Step  1 Start the Setup application as described at the beginning of this chapter. 
At the Setup menu, use the cursor key to select LCD and press the 
Enter key.

Step  2 Again use the cursor key to select Back Light Level and press the Enter 
key. The LCD Setting Back Light Level window displays (below).

LCD Setting- Back Light Level window

Step  3 Press the control key for the desired level of display back light. Press the 
soft key for OK when complete.

Step  4 When all changes have been made, press the soft key for Save to save 
your settings.

Step  5 Press the soft key for OK to confirm that you really want to save your 
settings. Your display settings have now been changed.
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Font Size

:���������������������?���������	������������	)��

Step  1 Start the Setup application as described at the beginning of this chapter. 
At the Setup menu, use the cursor key to select LCD and press the 
Enter key.

Step  2 Again use the cursor key to select Font Size and press the Enter key. 
The LCD Setting Font Size window displays (below).

LCD Setting- Font Size window

Step  3 Press the control key for the desired size of the display font. Press the 
soft key for OK when complete.

Step  4 When all changes have been made, press the soft key for Save to save 
your settings.

Step  5 Press the soft key for OK to confirm that you really want to save your 
settings. Your display settings have now been changed. (These changes 
will not take affect until your Inaset phone has been reset.)
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Language
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Step  1 Start the Setup application as described at the beginning of this chapter. 
At the Setup menu, use the cursor key to select LCD and press the 
Enter key.

Step  2 Again use the cursor key to select Language and press the Enter key. 
The LCD Setting Language window displays (below).

LCD Setting- Language window

Step  3 Press the control key for the desired language on the Inaset display. 
(Only the available languages for Inaset will be displayed.) Press the soft 
key for OK when finished.

Step  4 When all changes have been made, press the soft key for Save to save 
your settings.

Step  5 Press the soft key for OK to confirm that you really want to save your 
settings. Your display settings have now been changed. (These changes 
will not take affect until your Inaset phone has been reset.)
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Screen Saver
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Step  1 Start the Setup application as described at the beginning of this chapter. 
At the Setup menu, use the cursor key to select LCD and press the 
Enter key.

Step  2 Again use the cursor key to select Screen Saver and press the Enter 
key. The LCD Setting Screen Saver window displays (below).

LCD Setting- Screen Saver window

Step  3 Press the control key for Enable to enable the Screen Saver function.

—If disabling this function, press the control key for Disable and skip to 
Step 5 below.

Step  4 Press the control key for Waiting Time, and enter the time period (in 
minutes) before the Screen Saver begins. This would be the period of no 
activity on Inaset before the Screen Saver would begin.

Step  5 Press the soft key for OK, then press the soft key for Save to save your 
settings.

Step  6 Press the soft key for OK to confirm that you really want to save your 
settings. Your display settings have now been changed. (These changes 
will not take affect until your Inaset phone has been reset.)
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Feature Options

����:�������"�������	�������	�������	���������
�������������������
������
������

Microphone On / Off

������������
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��������/�-/��.

Step  1 On the Home Application window, press the control key for Function 
Keys.

Step  2 Press the control key for Feature, and press the 1 dial key. The Mic lamp 
will illuminate when the Microphone is on.

Step  3 Repeat the previous steps to alternately turn the microphone On/Off as 
needed.

Select Ringer Tone
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Step  1 On the Home Application window, press the control key for Function 
Keys.

Step  2 Press the control key for Feature, and press the 3 dial key. A ringer tone 
will be heard. Each additional press of the 3 key will sound a different 
ringer tone. Stop on the desired ringer tone by pressing any key on the 
dial pad (other than the digit 3).

Transmission / Receiving Volume

���������������
����������*�������������	��	��-5�
�	�	���������.

Step  1 On the Home Application window, press the control key for Function 
Keys.

Step  2 Press the control key for Feature, and press the 4 dial key. The Transmit 
volume increases.

Step  3 Again press the soft key for Function Keys, then the control key for 
Feature and press the 4 dial key to return the Transmit volume to 
normal.

TIP

The built-in microphone can also be turned on/off be pressing the Mic key on the 
Inaset lower panel.
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Activate Ringer

����
�	���������
�������	����.

Step  1 On the Home Application window, press the control key for Function 
Keys.

Step  2 Press the control key for Feature, and press the 0 dial key. Ringer 
activates.



3-16         Setup Options

Inaset User Guide - Issue 1.0

Security Password
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Setting (or Changing) Your Password

:��������������������������
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Step  1 Start the Setup application as described at the beginning of this chapter. 
At the Setup menu, use the cursor key to select LCD and press the 
Enter key.

Step  2 Again use the cursor key to select User and press the Enter key. The 
User Setting window displays (below).

User Setting window

Step  3 Press the control key for Old Password, and enter your current (old) 
password you are now using.

Step  4 Press the control key for New Password, and enter your new password.

Step  5 Press the control key for Re-enter New Password, and enter your new 
password again to verify. Press the softkey for OK when finished.

Step  6 Press the soft key for OK to confirm that you really want to save your 
settings. Press the Home key to return to the Home application.

NOTE

When using this feature for the first time, their will be no Old Password.
Using the cursor key, delete the ***** characters in the Old Password field before 
proceeding.
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4
Call Functions
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Home Application Window
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Home Application window
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Home Application window Description

Line Status Icons
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Line Status Icons
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Field / Key Description

1 PBX Information
Display

Information from the PBX will display in this area. This would include 
PBX time, date, and call status information.

2 Line Status Shows a visual icon display of the status for all assigned Line Keys.

3 Settings A visual indicator for the current settings of volume and display 
contrast.

4 Soft Keys Soft keys will appear in various operating modes.

5 Menu Control Keys Control keys are used to select the various menu functions.
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Home Menu
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Home Application Menu
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���������������������	�	�������������������
	�	
�
�	���"�����������
�	�������	�������������
������,

1 @���A
B? ����!%%�"��������	��������0"����������	���
���
�	������	�����������������	��������������������
�����	�������"����+%�����������B������	����	�������
	�������	������
���	���	��������!%%�9����,

1 ;��
>�=��A
B? %���
�����	�	�����
�������
�	�������	��������������

������



4-4         Call Functions

Inaset User Guide - Issue 1.0

Phone Login


���������������	����������������������������������������
"���������	��
��������������������������	����������	)����������	�����	��
������

���	����������������	
�����������������������������������	�	���������

�������
���������������
���	��������������������	�����������������
������������	���������	��
������������+%���������������������
���	�	��������������������	�����������������������,

@��������������	��	����&�	���������
������;��	���	������	������������

������	���	������������+���������,�

Inaset Login window

Manual Login :������������������������	����������
�����������.

Step  1 Enter your login number using the Dialing keys (0-9, *, #). When your 
number is entered, press the soft key for Set on the display. (If you make 
an incorrect entry, press the soft key for Cancel to clear your entry and 
then re-enter your number.)

Step  2 Now enter your password number using the Dialing keys (0-9, *, #). 
When your number is entered, press the soft key for OK on the display. 
(If you make an incorrect entry, press the soft key for Cancel to clear 
your entry and then re-enter your number.)

Step  3 If login was successful, the time and date will display at the top of the 
Home application window. The Inaset phone is now ready to use.

NOTE

In automatic login mode, the Inaset Login window will not display. The phone system 
will automatically login your Inaset phone for you. No additional login is required by 
you.
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Account /Authorization Codes

%����#' ���������������&�	�������

�����
�������-���
������	)��	���
������	�����	���
������������
�������������
����������	�	�������������������
	�	
��

���������

�����

�����������������������������������5��	�������������	���
��
�	�������������	����

���������������	)��	���
������

Account Code

�������������

�����
���.

1 ;	���������������������E
�F
��"����������	��������
1 ���������������

����
������	��������	���"����������
����	
�����������

1 �������

����������+������C6��	�	��,���	��������	���
"����

1 *�����	�������������	������	�����������

����������

�������������������������	)��	�������.

1 ;	���������������������E
�F
��"����������	��������
1 ���������������

����
��������������	)��	��������
��	��������	���"��������������	
�����������

1 ������������	)��	����������	��������	���"����������
��
��������	
�����������

1 �������

����������+������C6��	�	��,���	��������	���
"����

1 *�����	����������	������	�����������

Forced Account Code

1 ;	���������������������E
�F
��"����������	��������
1 ���������������

����
������	��������	���"����������
����	
�����������

1 ������:��
����

����������+������C6��	�	��,���	�������
�	���"����

1 *�����	����������	������	�����������

Access Code ____________________________

Account Code ____________________________

Access Code ____________________________

Authorization Code____________________________

Account Code ____________________________

Access Code ____________________________

Forced Account Code __________________________
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Authorization Code

������������������	)��	���������	����������

����������
+#��
������C,.

1 ;	���������������������E
�F
��"����������	��������
1 ���������������

����
������	��������	���"����������
����	
�����������

1 ������������	)��	��������+������C6��	�	��,���	�������
�	���"����

1 *�����	����������	������	�����������

������������������	)��	���������	�������

����������
+#��
������2,.

1 ;	���������������������E
�F
��"����������	��������
1 !	������	�����������
1 
�����������	)��	��������	����&�	�����
������������
���
	����	��������

1 ������������	)��	������������
�����	���������	���

Access Code ____________________________

Authorization Code____________________________

Authorization Code____________________________

NOTE

Procedure 2 is available only if your PBX phone system is programmed with Least 
Cost Routing.
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Answering a Call

Using the Handset

1 #������	������	���	��	
��������������+!	������������

���	���������,

1 ;	�����������������������������	��
��������	���

Hands Free (Speakerphone mode)

1 #������	������	���	��	
�������������
1 #������E
�F
��"���������������������������
�"���+A	
�
"����	����/�,��������	��
��������	���

Making a Call

Internal Call

1 ;	������������������	��������
1 !	������	����������	�����������+!	�������������	�����
�������,

1 ;	���������
�����������������������������	��

��������	���

External Call

1 ;	������������������	��������
1 !	�����������	��0�	����

����
�����+�����7,�
1 !	������	������������+!	�������������	������������,
1 ;	���������
�����������������������������	��

��������	���

Hands Free (Speakerphone mode)

1 #������E
�F
��"����������	��������
1 !	������	�����������
1 ;	���������
�������������������������������
�"���+A	
�
"����	����/�,��������	��
��������	���

NOTE

The top of the Inaset Home Application window shows call information as the call 
progresses or when a call function is used. An example display of this information is 
shown at left (when applicable) for all call functions described in the following.

Internal call

External call

Outside Access Code ________________________
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Putting a Call on HOLD

��������	������
������
��������
�	���
������������

1 
��	
�������������������������	�������������	������
���
	����������������

1 #�����G=HI�"����+!	������������
���������*����,

To Retrieve a Call on Hold

1 ;	���������������������E
�F
��"���
1 #�����
�������"�������D��
�A
B?�
1 #����������	���"���+����������
J>����������,���������
�	�����������

If Unanswered

�����������0������������	����	�����
�������������
�������	
�5�
����	��	�	�	�����+	���������,�����	���������
���	�����	�����+�	���"��������������	��������,�	��������������
����	�����������
�������
������������

Last Number Redial

5��	��������������������	�����

1 #�����
�������"�������;��
>�=��A
B?�
1 #�����
�������"�������C
I��H��+!	����������������
�������������	���,

1 5����������������2����������	���������	�����������	��
�	��������+����������D�����	�������	������������,�

1 #���������:�"�����������������������	������	��
�������	
������	�����

Transferring a Call

1 ������
������	������"�������������������
1 #���������?K
��"���������	������������	��������
1 !	�������	���	�������	���������	���������������������	��
��������	���	�������������

l

l
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Callback

%�������������	
�������
"��������
�������������	�������

1 #�����
�������"�������D��
�A
B?�
1 #�����
�������"���������HH��
F��*��������	
�����������
1 *���������������
1 @�������������	�����
����	����������
�������	����	����
@��������
������	����������������
����������	����	���
������	���

Making a Conference Call

Using Programmed Soft Key

1 @	�����
����	��������������"���������������
1 #���������?K
��"���������	������������	��������
1 !	������	�����������
1 ����������
����	�����������������������"��������=�K��
+������������
��	
����	����	�������������
������
�
�����,

1 �������0����
�������
��	��������	���������	��

��������	���

Using Function Key

1 @	�����
����	��������������"���������������
1 #���������?K
��"���������	������������	��������
1 !	������	�����������
1 ����������
����	������������������
�������"�������
;��
>�=��A
B?�

1 #�����
�������"��������=�K
�
�

���������0����

�������
��	��������	���������	��
��������	����+����
��������
��	
����	��������������
�������
�����,

NOTE

Contact your phone system administrator to determine if your Inaset has this function 
configured and how to specifically access it.
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Consult Third Party during a Call

@������������	����
�������������	������
�����������	���
������

1 #���������?K
��"����/�	�	����
������	���������	
�����
���
�����������

1 !	����������	������	������������
�������
1 #���������?K
���������������������	�	����
���������	���
������	���������	
��������
�����������

1 ����������������������?K
��"��������	�
����������
�������	�	����
����������������	���������

Call Camp-On

Answer a Camped-On Call

1 @�	�����������	����
�������
�	�������
���0��������
+��������������������,�

1 #�����
�������"�������D��
�A
B?�������������
�������
"���������?L
���������	�	�����
�	���
����	�����
������
�����������
�	������
�����0���
����	��������	������
+�����������	
����	��������������
�������
�����,

1 #�������?L
�����������������	�	����
���������������0
���
����	�����
�����������

1 5�����������	�������
�������"�������;��
>�=��A
B?�
��������
�������"���������?L
������������������������
�������	�	����
������������������
�����+!	������	��	
�����
����
����
��������	����������"���������	�����	���,

Set Camp-On (Transfer Method)

1 @�	�����������	����
�������"����������������#�����
����?K
��"������������������	��������

1 !	������	��������	������������������������
1 #�����
�������"�������D��
�A
B?�������������
�������
"���������	E=�������0/�������+2�������������,�	��
�����������������	���

1 *���������������

NOTE

Contact your phone system administrator to determine if your Inaset has this function 
configured.
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Set Camp-On (Call Waiting Method)

1 (���
����������	��������	��������*���������������������
����?K
��"���

1 #�����
�������"�������D��
�A
B?�������������
�������
"���������	E=�������0/�������+2�������������,�	��
�����������������	���

Call Park

�����#��"������������������
����
����E�������E���������������
��������	��������
�������������������������������������

Park a Call

1 @�	�����������	����
���������������?K
��"���
1 !	������������#��"��

����
�����
����	���������"����
!	������������*;!F+�������
��	������������F660
C7,�

Retrieve a Parked Call

1 !	��������#��"�����	�����
����
1 !	����������"���
������
��	����������+660C7,�
1 %���	���	������
����
��������������"���
����

Call Park Access Code ________________________

Call Park Retrieval Code___________________
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Call Forwarding

Forward All Calls

����	�
��	���
�������������
�������	����������������

1 ;	���������������������
�������"�������D��
�A
B?�
1 #�����
�������"�������;LI(�HH�
1 !	������������������������
������	��������������������
+!	������������
����:������������	������,

Forward - While Busy


�
��	���
�������������
�������	��������������������������
������	���	�������

1 ;	���������������������
�������"�������D��
�A
B?�
1 #�����
�������"�������;LI(M�?B�
1 !	������������������������
������	��������������������
+!	������������
����:������������	������,

Forward - When No Answer


�
��	���
�������������
�������	��������������������������
������	���������������������	���

1 ;	���������������������
�������"�������D��
�A
B?�
1 #�����
�������"�������;LI(�=��?L
��
1 !	������������������������
������	��������������������
+!	������������
����:������������	������,

Cancel Call Forwarding

@��������
������	��	�������:�����������������;@�������"���
�	�������

1 ;	��������������������������"�������;@���+!	������
������������������������	��
��
�����,

NOTE

Contact your phone system administrator to determine if your Inaset has this function 
configured.

l

l

TIP

While in Call Forward mode, press the soft key for FDA at any time to display the 
number the Inaset is forwarded to.
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Save & Redial a Number

(���
�����������	�����������������������������	��	����������
���������
�������	�����������������������	�����

Save a Dialed Number

1 ;	���������������������E
�F
��"���
1 !	������	�����������
1 #�����
�������"�������D��
�A
B?�
1 #�����
�������"��������)C��!	������������	������
�������

Verify a Saved Number

1 @	���
������	�����������
�������"�������D��
�A
B?�
1 #�����
�������"��������)C��+!	�������������������
�������,

Redial a Saved Number

1 ;	���������������������E
�F
��"���
1 #�����
�������"�������D��
�A
B?�������������
�������
"��������)C���������	���	������������	
�����

NOTE

Contact your phone system administrator to determine if your Inaset has this function 
configured.

NOTE

If the saved number is busy or did not answer when dialed, press the control key for 
S&R to save the number again before hanging up.
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Call Pick-Up

�����#	
"0$��������������������������������	��	����������	��
�����
�����	
"0��������������������
������������

1 @�������������	����+	�������
�����	
"0��������,���	���
������������������
�������"�������D��
�A
B?�

1 #�����
�������"���������HH���
F�E��'��	��
���������	���

If Currently on a Call

1 #���������?K
��"���������������
�������"�������D��
�
A
B?�

1 #�����
�������"���������HH���
F�E��(������	�	����
����	��
���
���������������	��
��������	����	�������
�����	
"���

������

1 #���������?K
�����	����������������������	�	����
������

Outgoing Trunk Queuing

(���
���&���������������	���
�������������#' ��������
����"�����������

1 !	�����������	�������"�
�������������������"�������
	��	
��	����������
�������"�������D��
�A
B?�

1 #�����
�������"���������HH��
F��5����
�����������(����

����	�����
���	��&�����������������	����������"�

1 @����������"�	�����	������������
�������	����	����;	���
����������	��������	���������!	������	�����������

NOTE

Contact your phone system administrator to determine if your Inaset has this function 
configured.
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Paging

Meet-Me Page

��	������������������
�	�������������������
����
���	�����

������	�������������
����

Example: ��������"�	����������������/���$�����������/�
���#����������
�	������$�'��
��	����	����

To Page (Station A)

1 !	���#��	����

����
����������
���	�������	����
"�����
������
����

1 #����%���	���'�
1 5���	���������"��������������������

To Answer (Station B, if Station A remains off hook)

1 !	���A���0A���������
�����������������	����	������

����
�����	��������
����

To Answer (Station B, if Station A has hung up)

1 !	���A���0A���������
���������%���	�����
�������	����
1 %���	������	������������������������
����
����

NOTE

Contact your phone system administrator to determine if your Inaset has this function 
configured.

Paging Access Code ________________________

Meet-Me Answer Code ________________________

Meet-Me Answer Code ________________________
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Paging Transfer

#��	������������	������������������
�	������	���������
����
����������������������������������������������	�����"�

Example: ��������"�
�	��(�����	�##�
�
���������/��$�����
���'�

����$��
���������������"���������������/��
�$�����������/����#���$��������������
�	�����
��������"�	�������&�	���$��	�##������
���
�
�������
��������/�<����$���(�
��$������������/���'�%��
&����=�

Paging (Station A)

1 ��"�
���	����������������������������?K
��"������������
	������������	��������

1 !	���#��	����

����
����������
���	�������	����
"�����
������
����

1 #����%���	���'�
1 5���	�����0���"��������������������

To Answer (Station B, if Station A remains off hook)

1 !	���#��	����������
�����������������
����
�����	���
����%���	������%���	�����������
���
����

1 %���	���������������������������%���	���'�	��

����
�����	�������
������

To Answer (Station B, if Station A has hung up)

1 !	���#��	����������
�����%���	�����
�������	����
1 %���	�����������������������
���
����
1 %���	���������������������������%���	���'�	��

����
�����	�������
������

Paging Access Code ________________________

Paging Answer Code ________________________

Paging Answer Code ________________________
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Boss/Secretary Transfer

���������	���
���������	����������������������
����������
������������	����'���-%�
�����������������������������
%�
�������������������'���G��������	����+#��
�������������
����%�
�����������'����������	���
�������������,

Secretary

1 ;	������������������
�������"�������D��
�A
B?�
1 #��������
	�	
��	���"�����������'���G��	��	����	������"�
��������������

1 #���������
�������"�������D��
�A
B?����������	��������
�	���"�������'����������	���������	
�����������	�����

1 ������
��
�������'����

Boss Accepts Call

1 %�
����������������'���G��	���������
����	��������
���
1 '�����	����������������������	�������	���;	���"�������
���	���
��������	���

Boss Refuses Call

1 %�
�������������������
�������"�������D��
�A
B?�������
��������'���G��	������	���������������
���	����������
������
�����
���	���������
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Boss/Secretary Override

����/����	������
�	������������
��������������������	������
���	������������������	������������	��
����������
�����������
�����	��������	���	����	�����
�����������������
���������
�	����
��������
��������������������	�������
�����	�������������
�����

Setup Override Key

1 %�
���������������
�������"�������;��
>�=��A
B?������
�������������
�������"�������;
�>��
�

1 #�������
�������"�������@���A
B?��������������
�������
"������������������!%%�"����

1 !	��������'���-%�
�������/����	����

����
����
1 #�������G=	
�"����������
��������������������������

�������"�������;��
>�=��A
B?�

1 #�������
�������"�������C

�HH�
1 !	��������'���G�����	���������������������������

�������"�������;��
>�=��A
B?�

1 #�������
�������"�������;
�>��
�

Secretary

1 5�
�	����
��������'����������"��
��������������

1 #�������G=HI�"�����������	��������
1 #�������
�������"�������@���A
B?���������������

�������"�������M=??"�

�N<
���I
��*������	����
"�
�����

Boss (Accepts Interrupt)

1 *�����B����������������������
�������"�������;��
>�=��
A
B?�

1 #�������
�������"���������?L
������
����������	���
%�
��������/�	�	����
����	�����
�����������

1 %�
��������������������'����	��
����
�����������

������

1 '����
�����������������������	������
��������������
��	�	����
��������������	�����?L
��

Boss (Refuses Interrupt)

1 
��'�������������������������������������%�
�������
��������
�������"�������;��
>�=��A
B?���������������

�������"�������C

�HH�

1 %�
�������	����
����
�����������
������

NOTE

Contact your phone system administrator to determine if your Inaset has this function 
configured and how to specifically access it.

Override Access Code ________________________



Call Functions         4-19

Inaset User Guide - Issue 1.0

Boss (Refuses New Call)

1 #�������
�������"�������;��
>�=��A
B?�
1 #�������
�������"���������?L
������
����������	���
%�
��������/�	�	����
����	�����
�����������

1 '����
����������	���%�
������������������������"��
����
����

1 '����������������?K
��"������������������	�	����
����



4-20         Call Functions

Inaset User Guide - Issue 1.0

Executive Override

/����	���	����������	�����������
�������������������	��	��
�����

1 #�����
�������"�������D��
�A
B?�
1 #�����
�������"�������N<
���I
������	�����������
����	��������������	�����������	��	
�������	��
����	��
��	���	�����������

1 �������0����
�������
��	��������	�����

Do Not Disturb / Privacy

��	�����
�	����������������������	
������	�
��	���
�������������

������

Phone Idle

1 #����������"�������@�@��+!	�����������������!�!�
�����	������,�����!�!����������	����������	��	��	��

��
�����+���������,�

When Engaged in a Call

1 #����������"�������@�@��+!	�����������������#�	��
��
�����	������,�+��	�������	
���	�
��	���
�������������	���
��	��
�������
����,

Cancel DND Mode

1 @����	��!�!������������������"�������@�@��+!	������
����������!�!������	��
��
�����,

NOTE

Contact your phone system administrator to determine if your Inaset has this function 
configured.

NOTE

Contact your phone system administrator to determine if your Inaset has this function 
configured.

l

l
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Intercom


��������������#' ��������
�������	���������	����������	���
	����
������
�	����������	����
�����������������	�����
������	�����������������������
���	�����	���

Automatic Intercom

���	�	�	��������������	
�	����
���
���.

1 ;	���������������������E
�F
��"���
1 #�����
�������"�������D��
�A
B?�
1 #�����
�������"�������������*�����	����
"������

��������������������	
�	����
���
���.

1 #�����
�������"�������D��
�F
B?�
1 #�����
�������"������������
1 ;	������������������
��������	���

Manual Intercom

���	�	�	������A������	����
���
���.

1 #�����
�������"�������D��
�A
B?�
1 #�����
�������"������������
1 ;	������������������	����
"������
1 #�����
�������"���������O�+����
����������	��������
�	���
�	��	��,�

������������A������	����
���
���.

1 #�����
�������"�������D��
�F
B?�
1 #�����
�������"������������
1 ;	������������������
��������	���

NOTE

Contact your phone system administrator to determine if your Inaset has this function 
configured.



4-22         Call Functions

Inaset User Guide - Issue 1.0

Dial Intercom

���	�	�	������!	���	����
���
���.

1 ;	���������������������E
�F
��"���
1 #�����
�������"�������D��
�A
B?�
1 #�����
�������"�������@����
1 !	������	����	����
�����������*�����	����
"������

������������!	���	����
���
���.

1 #�����
�������"�������D��
�F
B?�
1 #�����
�������"�������@����
1 ;	���������������������E
�F
��"����������
��������	���

Timed Reminder

�����	�����
����������������	����	��������
�����������
���
	�	����	������	��
���������������������	�����������
����	����������	�������������	�����
���������������������
�	�������������������

Set a Reminder

1 ;	�����������
1 #�����
�������"�������D��
�A
B?�������������
�������
"���������	
I�C
	��I
��

1 !	����������	�����	���+	��230�����������,����������
������������	�����

Cancel a Reminder

1 ;	�����������
1 #�����
�������"�������D��
�A
B?�������������
�������
"���������	
I�C
	��I
��

1 #���������:�"���������	�������	�����	��
��
�����

NOTE

Contact your phone system administrator to determine if your Inaset has this function 
configured.
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5
Directory Application

��	��
����������
�	�������������������1������!	��
���������	
��	����(���

�����������!	��
���������	
��	����������
���������	��������	��
���������
��"����
����������	��
������������:���	�
��	���
����������
�����������	��
�	���������������*��������	
��	����
�����	������
�����G������������
�������	�����	�������	������!	��
�������������	
��	����	��
�������	�
����.

Chapter Topics 0 >������$����
�	��
'�"��#�	�����
0 ��
�	��
'�"��#�	�������������
0 *#�	������##��

����$����
�	��
'
0 "��������
'����#��������
�	��
'�6��
'
0 ����������$����
�	��
'

Using the Directory Application

�������������!	��
���������	
��	���������������
���"����������
������
����������������	����������
������A�	���������������������������"�������
@�C���NCP�����	����������!	��
�����A�	���	�����

Inaset Menu window
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Entering Text Using the Dial Keys

�����	���"����+607��8,�����������������������������������������	������
���	����
�������	�������	���������	��	����&�	�������������	�������$����
/��	�����
����	���#��������!	��
�����	�������	��������
���	���	�������
'�����������	
��	���

��
���	���"���
���������������������������	�����������������
����
�����
���"����������"��������������	���������������������"�����&���
�������
��������������

Example: �������
��$����9�������:

Step  1 Press 7 four times, then press cursor right.

Step  2 Press 6 once, then press cursor right.

Step  3 Press 4 three times, then press cursor right.

Step  4 Press 8 once, then press cursor right.

Step  5 Press 4 two times, then press cursor right.

/�����	����������������
�����������������%����9������������������������
�	�����+����,�
�������������������������������������"��������������	�����
���������������������	��	
�������
�����	�������������	����������	�����
��������������������������	��������������+	��	
��������
�,�����������
+	��	
����������,�

#����	����������	���"���+�������������	�������������,��	�������������

����
������� �!��"�#�$�+���
�,

#����	����������	���"���+�������������	�������������,��	�������������

����
�����%�&�'�(�)�*+�,�-�.�/���0��1��2�3�4�5�6�789���:
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Directory Application Windows

Directory Main Window

%����	�������!	��
���������	
��	����	������������!	��
�����A�	���	�����
+�����,��%�������������	������������������
�	��	����������"��������
���
�	�������	�����������	���	�����

Directory Main window

Directory Main Window Description

Field / Key Description

1 Directory Type Three directory types are available; Personal, Corporate, and 
Group. (See also item 5.)

2 Search Condition Three types of search conditions can be selected; keyword, last 
name, and company.

3 Search Box
Enter the data you want to search on here. The directory will be 
searched for a data match and the cursor will position to the data 
entry when a forward match occurs.

4 Directory List
The Directory List is a quick reference list of the registered data. 
Each of the three types of directory lists, Personal, Corporate and 
Group, allows registration of up to 200 items.

5 Directory Type Selector Soft key to select another directory type.

6 Detail Soft key to open the Directory Detail window for the selected 
(highlighted) Directory list entry.

7 Character Selects between Text and Numeric entry character modes.

8 Dial Soft key to place a call to the selected (highlighted) entry on the 
directory list.
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9 Directory Control keys

The control keys are used to select the Directory Main window 
functions.

• Search -Scrolls through the three types of search criteria 
(Keyword, Company, Last Name).

• File -Opens the File menu. Save or load directory data or 
upload and download data.

• Entry -Opens the Entry menu. Create, modify, and delete 
directory entry data.

• Display -The Display menu will open. Change the character 
size of the directory data or sort directory list data. 

• Setup -Opens the Setup Tool menu. Change select Detail field 
names.

• Exit -Exit the Directory Application and open the Inaset Main 
Menu window.

• -Scroll up the directory list data.

• -Scroll down the directory list data.

10 Character Entry Mode 
Indicator

The Character Entry Mode shows the type of character that can 
now be entered in the directory data search mode. 

• <123> indicates Numeric

• <abc> indicates Text

(The type of character that can be used in the search mode can be 
selected by the Character key.)

Field / Key Description
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Directory Detail Window

%���
�	������������+���������!	��
�����A�	���	����,���������������	���
����@
>��H�"����	����	����������!	��
�����!���	���	�����+�����,����	��
�	��������������������	������������
	�	
��	��
������������%�������������	���
���������������
�	��	����������"�����������
�	�������	�����������	��
�	�����

Directory Detail window

Directory Detail Window Description

Field / Key Description

1 No Directory data number. Choose any number from 1 to 500.

2 Name (First) First name for the directory entry.

3 Name (Last) Last name for directory entry.

4 Keyword Associated keyword for this entry that can be used in a data search.

5
Business

Home
Mobile

Shows a registered directory number(s). Up to three numbers can 
be assigned per person. You can place a call by selecting any of the 
keys (Business, Home, Mobile) and then press the soft key for Dial. 
(You can also change these 3 item names.)

6 Company The associated company name for this person.

7 Character Selects between Text and Numeric entry character modes.

8 Dial Soft ley to place a call to the selected directory number.
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9 Directory Control
Keys

The control keys are used to select the Directory Detail window 
functions.

• -Selects the first data entry on the directory list.

• -Selects the previous data entry (above) to the current 
entry.

• -Shows the following data entry (below) to the current 
entry.

• -Selects the data at the bottom of the directory list.

• Tab -Use to move the focus between fields on the Directory 
Detail window or to another entry detail window.

• Back -Use the key to hide the detail window and go back to 
the directly list.

• Delete -Use the key to delete the piece of data now on display. 

10 Character Entry Mode 
Indicator

The Character Entry Mode shows the type of character that can 
now be entered in the directory data search mode. The type of 
character that can be used in the search mode can be selected by 
the Character key. 

• <123> indicates numeric character mode

• <abc> indicates text character mode

Field / Key Description
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Placing Calls from the Directory

Place a Call from Directory Main Window

:����������������������
����
�������������!	��
�����A�	���	����.

Step  1 Using the Inaset cursor key, scroll to select the entry you want to call 
from the main directory list.

Step  2 Press the soft key for Dial. The Directory Application will place a call to 
the selected directory number.

Place a Call from Detail Window

(���
�������
������������������������������!���	���	������������
�	��
������������
����
���������������
�����	��
�������������:����������
�����������.

Step  1 Using the Inaset cursor key, scroll to select the entry you want to call 
from the main directory list.

Step  2 Press the soft key for Detail. The detail window for the selected entry will 
display.

Step  3 Using the Inaset cursor key, select one of three numbers to dial and 
press the Enter key.

Step  4 Press the soft key for Dial. The Directory Application will place a call to 
the selected directory number.

Place a Call by Searching the Directory

:��������!	��
�����A�	���	����������
�������
������!	��
�����;	���������
���
	�	
����������������
��	����������	���������������
������
����
�������
������	��
�������������:���������������������.

Step  1 Press the soft key to select the type of directory (Corporate, Group, 
Personal) to search.

Step  2 Press the control key for Search to select Search mode.

Step  3 Continue to press the Search key to select the search criteria (Keyword, 
Last Name, Company).

NOTE

After a call has been dialed from the Directory, Inaset will automatically change the 
screen from the Directory menu to the Home screen. This allows the caller to use the 
Dterm features of the Inaset while on a call (i.e. Conference, Hold, etc.).
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Step  4 Using the Inaset dial keys, enter the data to search (up to 41 characters). 
(See Entering Text Using the Dial Keys in this chapter.) 

Step  5 When a directory match is found, the entry will be highlighted. Press the 
soft key for Dial. The Directory Application will then place a call to the 
selected directory number.

—The number entered in the Business field of the Directory entry is the 
number that will be dialed when pressing the Dial key.

—To dial one of the alternate numbers for this Directory entry, press the 
soft key for Detail. Use the cursor key to select one of the three 
numbers to dial and then press the Enter key. Press the soft key for 
Dial to dial the selected number.

NOTE

When exiting the Detail window, the number that can be dialed by pressing the ’Dial’ 
soft key will return to the default, which is the Business field
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Add, Modify, Delete a Directory Entry

Add a Directory Entry

:��������������������������������������	��
������	��.

Step  1 Press the control key for Entry. The Directory Entry menu opens.

Step  2 Using the cursor key, select New and then press Enter (on the Inaset 
lower panel). The Directory Data detail window opens.

Step  3 Enter the information in the appropriate fields for the new directory entry. 
(See Entering Text Using the Dial Keys in this chapter.)

Step  4 When all data has been entered, press the soft key for Add and then 
press the control key for Back to return to the Directory Main window.

Step  5 To save the new entry data, press the control key for File. The File menu 
opens.

Step  6 Using the cursor key, select Save and then press Enter (on the Inaset 
lower panel). If the data is saved without error, a message box displays.

Step  7 Press the soft key for OK to confirm and close the message box.

Modify a Directory Entry

:����������������������	�����	��	��������	�������	��
������	��.

Step  1 At the Directory Main window, use the cursor key to highlight the 
directory entry to modify from the entry list.

Step  2 Press the control key for Entry. The Edit Entry menu opens.

Step  3 Using the cursor key, select Modify and then press Enter (on the Inaset 
lower panel). The Directory detail window opens.

Step  4 Modify the entry data as needed and press the soft key for OK when all 
changes have been made. (See Entering Text Using the Dial Keys in this 
chapter.)

Step  5 Press the control key for Back to return to the Directory Main window. 

Step  6 To save the changes, press the control key for File. The File menu 
opens.

Step  7 Using the cursor key, select Save and then press Enter (on the Inaset 
lower panel). If the data is saved without error, a message box opens.

Step  8 Press the soft key for OK to confirm and close the message box.

NOTE

There is no need to enter a Number in the No field. This field will be automatically 
populated with the next numerical entry.
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Delete a Directory Entry

:����������������������������!	��
���������������������	��
������	��.

Step  1 At the Directory Main window, use the cursor key to highlight the 
directory entry to delete.

Step  2 Press the control key for Entry. The Edit Entry menu opens.

Step  3 Using the cursor key, select Delete and then press Enter (on the Inaset 
lower panel). A message box opens to confirm the delete. 

Step  4 Press the soft key for OK to confirm the delete and close the message 
box.

Step  5 To save the directory changes, press File. The File menu opens.

Step  6 Using the cursor key, select Save and then press Enter (on the Inaset 
lower panel). If the data is saved without error, a message box opens.

Step  7 Press the soft key for OK to confirm and close the message box.
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Managing the Directory

Download Data

�����	��
����������
��������������������������:�#�������������
������
������
����
�������:���������������������������������	��
����������
�������������:�#�������.

Step  1 Press the soft key to select the Directory to download (Personal, 
Corporate, Group).

Step  2 Press the control key for File. The File menu opens.

Step  3 Using the cursor key, select Download and then press Enter (on the 
Inaset lower panel).

Step  4 At the dialog box, enter the address (using the dial keys) of the FTP 
server storing the data you want to download.

Step  5 Press the soft key for OK to start the data download from the designated 
server and then press the control key for Back to close the download 
window.

Step  6 When the data has been downloaded, it must be loaded into the Inaset 
memory before use. Press the control key for File. The File menu opens.

Step  7 Using the cursor key, select Load and then press Enter (on the Inaset 
lower panel). The directory data will be loaded and displayed.

Upload Data 

!����
���������������������������:�#�������������
������������
����
���
����:�����������������������������������������
�������������������:�#�
������.

Step  1 Press the soft key to select the Directory to upload (Personal, Corporate, 
Group).

Step  2 Press the control key for File. The File menu opens.

Step  3 Using the cursor key, select Upload and then press Enter (on the Inaset 
lower panel).

Step  4 At the dialog box, enter the address (using the dial keys) of the FTP 
server to upload data to. 

NOTE

Check with your phone system administrator before performing the following 
procedures.



5-12         Directory Application

Inaset User Guide - Issue 1.0

Step  5 Press the soft key for OK to start the data upload to the designated 
server and then press the control key for Back to close the upload 
window.

Changing Directory Character Font Size

:�������������������
�����������	��
�����
����
����������	)�.

Step  1 Press the control key for Display. The Display menu opens.

Step  2 Using the cursor key, select Font Size and then press Enter (on the 
Inaset lower panel).

Step  3 At the Change Font Size dialog box, use the cursor key to select the 
Normal or Large font size and press the Inaset Enter key.

Step  4 Press the soft key for OK to complete the change. The character size of 
the directory will now reflect the change.

Sorting Directory List

:�����������������������������	��
������	��.

Step  1 Press the control key for Display. The Display menu opens.

Step  2 Using the cursor key, select Sort and then press Enter (on the Inaset 
lower panel).

Step  3 At the Change Sort Key dialog box, select a condition for sorting list data:

—Use the cursor key to select Keyword, and press Enter to sort the 
directory in alphabetical order by keyword.

—Use the cursor key to select No., and press Enter to sort the directory 
in numeric order by entry number.

—Use the cursor key to select Company, and press Enter to sort the 
directory in alphabetical order by company name.

Step  4 Select an order for the sort:

—Use the cursor key to select Ascending, and press Enter to sort data 
in ascending order.

—Use the cursor key to select Descending, and press Enter to sort 
data in descending order.

Step  5 Press OK to complete the sort. The data in the directory list is sorted in 
the specified order.
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Changing Item Name in Detail Window

%����	�����	����������
������
��������������!	��
�����!���	���	������
:�������������������
���������	��������.

Step  1 Press the control key for Setup. The Setup menu opens.

Step  2 Using the cursor key, select Setting and then press Enter (on the Inaset 
lower panel). The Change Item Name dialog box opens.

Step  3 Use the cursor to select the item field to change. Using the dial keys, 
enter the new item name in the selected fields. (You can enter a 
maximum of 10 single- or double-byte characters.) (See Entering Text 
Using the Dial Keys in this chapter.)

Step  4 Press OK to complete the changes. The item names in the detail window 
reflect the changes made.
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Browser Application
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Using the Browser
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Inaset Menu window
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Entering Text Using the Dial Keys
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Example: �������
��$����9�������:

Step  1 Press 7 four times, then press cursor right.

Step  2 Press 6 once, then press cursor right.

Step  3 Press 4 three times, then press cursor right.

Step  4 Press 8 once, then press cursor right.

Step  5 Press 4 two times, then press cursor right.
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Browser Application Window

%����	�������'�����������	
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Browser Main window - Normal View

Control keys
Display Area

Enter key

Soft keys

Cursor key
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Main Window Description

Field / Key Description

Display area Browser display area for selected web pages.

Soft Keys
(Navigation Keys)

The Browser Soft Keys allow you to navigate the browser pages, similar 
to your desk computer browser.

back - Displays the previous browser page

forward - Displays the next browser page

home - Displays the preset home page

stop - Stops loading the current page

Note:  These Soft Keys can be reconfigured, as described later in this 
guide. The navigation functions are the default configuration for the 
Browser Soft Keys.

Control Keys

The control keys select the Browser Main window functions:

• Go - Displays the Go menu.

• Edit - Displays the Edit menu. Edit various browser keys and
  options.

• #App1 - Selects a preset web page.

• #App2 - Selects a preset web page.

• #App3 - Selects a preset web page.

• - Scroll from top to bottom between the different hot links
 displayed on the web page.

• - Scroll from bottom to top between the different hot links
 displayed on the web page.

Enter Key Selects the highlighted option.

Cursor Key Scroll up/down and left/right on the displayed URL.
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Telephony (PBX) Display

�����������	������������	������+�����,�����������������+#' ,�
	�������	����������������������	�������������	���������������������������
"�����%���������
�	���@���������#��$��'�*/A�1�
�
�������������	����	��

�������

Browser Main window - Telephony Display
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Using Your Home Page

������*����#����
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Viewing the Home Page

:�������������������	������������*����#���.

Step Press the soft key for Home. The Inaset preset web Home Page will open.

Setting the Home Page

��*����#������������������������������������������*����#�����	���
�	������	���������������	������:��������������������������������������
�������.

Step  1 From the Browser Main window, press the control key for Edit. The Edit 
menu window opens.

Step  2 Press the control key for Options. The Browser Option Setting window 
opens (below).

Browser Option Setting window

NOTE

The Home soft key does not display in the Telephony view mode. To use the Home 
key function in this mode, press the control key for Go, then the key for home.
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Step  3 Using the dial keys on the Inaset lower panel, enter the Web address of 
your Home Page in the Home Page URL field. (A maximum of 127 
characters can be entered.)
(See Entering Text Using the Dial Keys in this chapter.)

—Selecting To a Default will set the home page URL address specified 
by your phone system administrator as your current home page.

Step  4 Press the soft key for OK to save your address.
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Setting for a Proxy Server
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���	����������
������'�������������������������.

Step  1 From the Browser Main window, press the control key for Edit. The Edit 
menu window opens.

Step  2 Press the control key for Options. The Option Setting window opens 
(below).

Browser Option Setting window

Step  3 Press the control key for Use Proxy Server to check the Proxy Settings 
checkbox.

Step  4 Press the control key for Address, and enter the IP address for the proxy 
server using the Inaset dial keys. (See Entering Text Using the Dial Keys 
in this chapter.)

Step  5 Press the control key for Port Number, and enter the port number for the 
proxy server using the Inaset dial keys. (If no or an invalid port number is 
entered, Inaset will use a default port number of 80.) (See Entering Text 
Using the Dial Keys in this chapter.)

Step  6 Press the soft key for OK to save the settings.

NOTE

Contact your phone or local network system administrator to determine if the proxy 
server settings must be configured for your Inaset. (These settings may have already 
been configured by your administrator.)
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Using Application Pages
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Viewing Application Pages

:��������������������	����������������	
��	��������

Step  1 From the Browser Main window, press the control key for Go. The Go 
menu window opens. 

Step  2 Press the control key (#App1-8) to select the web page application to 
view. The selected web page opens. (Press next to select additional 
application pages.)

Setting the Application Page Presets

(���
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���	����:��������������������������������	
��	�����������������.

Step  1 From the Browser Main window, press the control key for Edit. The Edit 
menu window opens.

Step  2 Press the control key for Applications. The Application Setting window 
opens (below).

Browser Application Setting window
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Step  3 Press the control key to select one of the eight applications. In the 
Application Name field, use the dial keys to enter a title for the web 
page. (You can enter a maximum of 32 characters.)
(See Entering Text Using the Dial Keys in this chapter.)

Step  4 Press the control key on this application to select the address field. Enter 
the URL address for this web page in the URL field. (You can enter a 
maximum of 127 characters.) (See Entering Text Using the Dial Keys in 
this chapter.)

Step  5 Press the soft key for OK to save the settings.

%���������
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Go Menu
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Browser Go Menu window
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Configure Control & Soft Keys
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Changing the Control Key Functions
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Step  1 From the Browser Main window, press the control key for Edit. The Edit 
menu window opens.

Step  2 Press the control key for Control Keys. The Control Key Configuration 
window opens (below).

Browser Control Key Configuration window

Step  3 Press the control key for Control Key 1. Continue to press the adjacent 
control key until the desired Application page name (or other key 
function) appears in the field.

Step  4 Configure the remaining control keys as needed.

Step  5 When finished, press the soft key for OK to save these settings.
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Changing the Soft Key Functions
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Step  1 From the Browser Main window, press the control key for Edit. The Edit 
menu window opens.

Step  2 Press the control key for Soft Keys. The Soft Key Configuration window 
opens (below).

Browser Soft Key Configuration window

Step  3 Press the control key for the specific soft key to change. Repeatedly 
press the control key as needed to select the desired key function.

Step  4 Configure the other soft keys as needed.

Step  5 When finished, press the soft key for OK to save these settings.

NOTE

These soft keys only display when the display is set to normal view mode.
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Viewing Telephony PBX Information
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Step  1 From the Browser Main window, press the control key for Edit. The Edit 
menu window opens.

Step  2 Press the control key for View. The View Setting window opens (below).

Browser View Setting window

Step  3 Press the control key for Show Telephone Display (U/L) to set the 
Browser to display telephone information.

Step  4 Press the control key for Normal to select the normal Inaset Browser 
display.

Step  5 Press the control key for Save View Setting to select the checkbox if 
you want this setting to be saved and used the next time you start the 
Browser application.

Step  6 Press the soft key for OK to save the settings.
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